
 

海得科技 PX 系列用户指南 i 

 

PX 系列 

高达 40 GHz 

手持式 

实时频谱仪  



 

海得科技 PX 系列用户指南 i 

 

 

目录 

1. 版本管理 ....................................................................................................................................... 1 

2. 快速入门指南 ................................................................................................................................ 2 

2.1 安全指导 ......................................................................................................................................... 2 

2.1.1 安全细则 ............................................................................................................................... 2 

2.1.2 更换电源适配器 ................................................................................................................... 3 

2.1.3 更换电池 ............................................................................................................................... 3 

2.2 外部接口说明 ................................................................................................................................. 3 

2.3 仪器首次使用 ................................................................................................................................. 5 

2.3.1 打开和关闭仪器 ................................................................................................................... 5 

2.3.2 充电指示灯 ........................................................................................................................... 5 

2.3.3 运行 SAStudio4 ...................................................................................................................... 5 

3. SAStudio4 概述与通用操作 ........................................................................................................... 6 

3.1 工作模式介绍 ................................................................................................................................. 6 

3.1.1 标准频谱分析模式（SWP） ................................................................................................ 6 

3.1.2 IQ 流模式（IQS） ................................................................................................................. 6 

3.1.3 检波分析模式（DET） ......................................................................................................... 7 

3.1.4 实时频谱分析模式（RTA） ................................................................................................. 7 

3.1.5 相位噪声测量模式（PNM） ............................................................................................... 7 

3.1.6 数字解调模式（选件，Beta 版） ....................................................................................... 7 

3.2 界面布局 ......................................................................................................................................... 7 

3.2.1 菜单栏 ................................................................................................................................... 8 

3.2.2 图表设置区 ........................................................................................................................... 8 

3.2.3 主设置区 ............................................................................................................................... 8 

3.2.4 仪器状态栏 ........................................................................................................................... 9 

3.3 SAStudio4 常用功能介绍 ............................................................................................................... 9 

3.3.1 保存和打开仪器配置 ........................................................................................................... 9 

3.3.2 设置启动状态 ..................................................................................................................... 10 

3.3.3 切换工作模式 ..................................................................................................................... 11 

3.3.4 保存截图 ............................................................................................................................. 11 

3.3.5 查看 GNSS 信息 .................................................................................................................. 12 

3.3.6 预设 ..................................................................................................................................... 13 

3.3.7 单次与连续预览 ................................................................................................................. 13 

3.3.8 快捷记录与回放 ................................................................................................................. 14 

3.3.9 专业和简洁设置 ................................................................................................................. 15 

3.3.10 隐藏面板 ............................................................................................................................. 15 

3.3.11 查看当前仪器信息 ............................................................................................................. 16 

3.3.12 游标功能 ............................................................................................................................. 16 



 

海得科技 PX 系列用户指南 ii 

3.3.13 瀑布图 ................................................................................................................................. 22 

3.3.14 局部放大图 ......................................................................................................................... 22 

3.3.15 记录与回放 ......................................................................................................................... 24 

3.3.16 导出数据 ............................................................................................................................. 26 

3.3.17 删除文件与图像 ................................................................................................................. 27 

3.3.18 采样率修改 ......................................................................................................................... 28 

3.3.19 快捷参数设置 ..................................................................................................................... 28 

4. SWP 模式的使用 ......................................................................................................................... 30 

4.1 SWP 模式通用参数介绍 .............................................................................................................. 30 

4.2 信道功率 ....................................................................................................................................... 31 

4.2.1 参数说明 ............................................................................................................................. 31 

4.2.2 操作步骤 ............................................................................................................................. 31 

4.3 占用带宽 ....................................................................................................................................... 32 

4.3.1 参数说明 ............................................................................................................................. 32 

4.3.2 操作步骤 ............................................................................................................................. 32 

4.4 邻道功率比 ................................................................................................................................... 33 

4.4.1 参数说明 ............................................................................................................................. 33 

4.4.2 操作步骤 ............................................................................................................................. 33 

4.5 IP3/IM3 .......................................................................................................................................... 34 

4.5.1 参数说明 ............................................................................................................................. 34 

4.5.2 操作步骤 ............................................................................................................................. 35 

4.6 频率追踪 ....................................................................................................................................... 35 

4.7 峰值表 ........................................................................................................................................... 37 

5. IQS 模式的使用 ........................................................................................................................... 38 

5.1 IQS 通用参数介绍 ........................................................................................................................ 38 

5.2 IQS 模式功能简介 ........................................................................................................................ 39 

5.3 频谱分析 ....................................................................................................................................... 39 

5.3.1 参数说明 ............................................................................................................................. 39 

5.3.2 操作步骤 ............................................................................................................................. 39 

5.4 IQvT ............................................................................................................................................... 40 

5.4.1 操作步骤 ............................................................................................................................. 40 

5.5 PvT ................................................................................................................................................. 41 

5.5.1 操作步骤 ............................................................................................................................. 41 

5.6 AM 解调 ........................................................................................................................................ 41 

5.6.1 参数说明 ............................................................................................................................. 42 

5.6.2 操作步骤 ............................................................................................................................. 42 

5.6.3 音频分析 ............................................................................................................................. 42 

5.7 FM 解调 ........................................................................................................................................ 43 

5.7.1 参数说明 ............................................................................................................................. 43 

5.7.2 操作步骤 ............................................................................................................................. 43 

5.7.3 音频分析 ............................................................................................................................. 44 



 

海得科技 PX 系列用户指南 iii 

5.8 DDC 数字下变频 ........................................................................................................................... 44 

5.8.1 参数说明 ............................................................................................................................. 45 

5.8.2 操作步骤 ............................................................................................................................. 45 

6. DET 模式的使用 .......................................................................................................................... 48 

6.1 DET 通用参数介绍 ....................................................................................................................... 48 

6.2 脉冲信号测量 ............................................................................................................................... 48 

6.2.1 操作步骤 ............................................................................................................................. 48 

6.3 脉冲信号检测（选件） ............................................................................................................... 49 

6.3.1 申请许可证 ......................................................................................................................... 49 

6.3.2 参数说明 ............................................................................................................................. 52 

6.3.3 操作步骤 ............................................................................................................................. 52 

7. RTA 模式的使用........................................................................................................................... 55 

7.1 RTA 通用参数介绍 ........................................................................................................................ 55 

7.2 概率密度图 ................................................................................................................................... 55 

7.2.1 参数说明 ............................................................................................................................. 55 

7.2.2 关闭概率密度图 ................................................................................................................. 55 

7.3 WIFI 信号测量 .............................................................................................................................. 56 

8. 数字解调（选件，Beta 版） ...................................................................................................... 57 

8.1 申请许可证 ................................................................................................................................... 57 

8.2 参数说明 ....................................................................................................................................... 57 

8.3 功能简介 ....................................................................................................................................... 58 

8.4 操作步骤 ....................................................................................................................................... 58 

9. 相位噪声测量模式 ...................................................................................................................... 60 

9.1 版本要求 ....................................................................................................................................... 60 

9.2 启用相位噪声测量功能 ............................................................................................................... 60 

9.3 参数说明 ....................................................................................................................................... 61 

9.4 操作步骤 ....................................................................................................................................... 61 

9.4.1 已知载波信息的相位噪声测量 ......................................................................................... 61 

9.4.2 未知载波信息的相位噪声测量 ......................................................................................... 63 

10. 其他功能的使用 ..................................................................................................................... 65 

10.1 GNSS 使用说明 ........................................................................................................................ 65 

10.1.1 连接 GNSS 天线 .................................................................................................................. 65 

10.1.2 查看 GNSS 信息 .................................................................................................................. 65 

10.1.3 使用 GNSS 模块的 1PPS 触发 ............................................................................................. 66 

10.1.4 GNSS 使用注意事项............................................................................................................ 67 

10.2 触发功能介绍 .......................................................................................................................... 67 

10.2.1 SWP 扫频模式 ..................................................................................................................... 67 

10.2.2 IQS、DET、RTA 定频点模式 .............................................................................................. 67 

10.3 中频输出应用指南 .................................................................................................................. 68 



 

海得科技 PX 系列用户指南 iv 

10.4 外部参考时钟输入 .................................................................................................................. 69 

10.5 远程控制指南 .......................................................................................................................... 70 

10.5.1 网口直连 ............................................................................................................................. 70 

10.5.2 局域网连接 ......................................................................................................................... 73 

11. 软固件更新 ............................................................................................................................. 77 

11.1 软固件更新规则 ...................................................................................................................... 77 

11.2 软固件更新包获取 .................................................................................................................. 77 

11.3 Updater 更新软固件 ................................................................................................................ 78 

11.4 .deb 安装包更新 SAStudio4 软件 ........................................................................................... 81 

11.5 异常处理 .................................................................................................................................. 84 

11.5.1 固件检测异常处理 ............................................................................................................. 84 

11.5.2 固件损坏异常处理 ............................................................................................................. 85 

11.5.3 SAStudio4 误删处理 ............................................................................................................ 86 

11.5.4 SAStudio4 更新异常处理 .................................................................................................... 86 



 

海得科技 PX 系列用户指南 1 

 

1. 版本管理 

版本更新说明表 

版本号 内容 时间 

V1.0 增加数字解调和脉冲选件测量说明 2025-3-27 

V1.1 
1.增加相位噪声测试功能说明  

3.修改触发功能介绍（以最新 SAS4 为准） 

2025-4-3 

V1.2 
DET 模式增加脉冲信号测试 

2025-4-8 

V1.3 
1.增加概率密度图章节 

2.删除 SWP 模式脉冲检测、数字解调硬狗使用说明 

2025-4-11 
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2. 快速入门指南 

本章为 PX 系列快速入门指南，主要内容包括安全指导，仪器开机和关机，运行 SAStudio4 软件和仪器外

部接口说明恒温。 

2.1 安全指导 

2.1.1 安全细则 

1.当您收到仪器，开启前请检查以下项目： 

▪ 仪器外观完好； 

▪ 电源线、适配器是否损坏； 

▪ 风扇出风口是否保持通畅； 

▪ 仪器是否干燥无潮，无冷凝； 

▪ 环境温度是否符合对应产品手册指定范围； 

▪ 使用前若发现仪器任何损坏，请联系海得科技官方售后服务。 

2.仪器使用过程中，请遵循以下准则： 

▪ 确保风扇正常工作且仪器工作温度符合对应产品手册指定范围； 

▪ 正确连接仪器所有相关外部接口且射频输入接口端信号电平符合产品手册指定范围； 

▪ 确保仪器电池电量高于 5%； 

▪ 不得打开仪器外壳，谨防电击； 

▪ 若出现故障或无法正常运行，请及时联系海得科技官方售后服务。 

3.仪器完成使用后，请遵循以下准则： 

▪ 仪器正常关机后，请将仪器存放温度和湿度满足产品手册指定范围的环境中。 
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2.1.2 更换电源适配器 

若您因某些情况无法使用原厂电源适配器，请务必根据对应产品手册，选择规格合适的电源适配器，以确

保仪器正常使用。 

2.1.3 更换电池 

海得科技为 PX 系列频谱仪提供更换电池服务，若您需要更换电池，请联系海得科技官方售后服务。 

2.2 外部接口说明 

为便于客户使用，海得科技将仪器的所有接口集成在顶层面板上，各接口对应的详细信息请查阅下表 1。 

 

表 1 仪器上面板接口说明 

序号 接口名称 描述 

1 电源开关 打开/关闭仪器 

2 充电端口 
仪器充电端口，USB PD 20 V 3.25 A，请按照仪器要求的工作

电压连接电源 

3 Micro HDMI 扩展显示 

4 USB3 USB 接口：其中 USB3 为 USB 3.0 接口，USB1 和 USB2 为 USB 

2.0 接口。通过该接口连接外部扩展存储器和 USB 键盘、鼠

标；或连接免驱动带网口的 Hub，通过网线连接至 PC，PC 对

仪器进行远程控制 

5 USB2 

6 USB1 

7 音频输出 
3.5 mm 耳机接口，可在菜单栏中通过“System”→

“Device”→“Volume”调节音量 

8 多功能 MUXIO 详细描述请见表 2 

9 充电指示灯 绿色闪烁为正在充电，绿色常亮为充满 
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10 模拟中频输出 MMCX (F)，最大输出功率-25 dBm，输出阻抗 50 Ω 

11 触发输出 3.3V CMOS 

12 触发输入 3.3V CMOS，输入阻抗为高阻 

13 参考时钟输入 
MMCX (F)，幅度≥1.5 Vpp，输入阻抗 330 Ω。参考时钟输入：

正弦、方波、削峰正弦均可 

14 GNSS 天线 MMCX (F)，幅度≥1.5 Vpp，输入阻抗 330 Ω 

15 射频信号输入 
PXE-200：N (F)，输入阻抗 50 Ω 

PXN-400：2.4mm (M)，输入阻抗 50 Ω 

表 2 端口 8 多功能 MUXIO PIN 接口说明（图示方向从左至右） 

引脚 名称 方向 电平标准 含义 

1 GPIO0 / / 预留 

2 TRG IO2 / / 预留 

3 GPIO1 / / 预留 

4 GND / / 接地 

5 GPIO2 / / 预留 

6 3V3/5VIN O / 
电源输出，PXN-400 和 PXE 系列 

5 V 输出 

7 GPIO3 / / 预留 

8 GND / / 接地 

9 USART_TX_FP / / 预留 

10 SYNC_RXRFLO I 3.3V 射频本振同步 

11 SYNC_ADCCLK I 3.3V ADC 时钟同步 

12 SYNC_RXIFLO I 3.3V 中频本振同步 

13 GND / / 接地 

14 REFCLK_OUT_FP O / 
参考时钟输出，可输出 10 MHz 标

准时钟信号 
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2.3 仪器首次使用 

仪器经过长途运输，电池电量可能会在 5%以下，建议首次使用前，先连接随寄电源适配器，再开机使用。 

2.3.1 打开和关闭仪器 

通过仪器上方的电源按钮（端口 1）打开/关闭仪器。仪器开机后，蓝色电源指示灯亮起，关机后，电源

指示灯熄灭。 

2.3.2 充电指示灯 

当仪器连接电源适配器后，充电状态灯（端口 9）闪烁绿色灯光，表示正在充电。当电池充满电后，充电

指示灯将变为绿色常亮。 

2.3.3 运行 SAStudio4 

按下电源按钮，仪器开机后进入桌面环境并自动打开 SAStudio4 工作软件。正常运行界面如下图所示： 
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3. SAStudio4 概述与通用操作 

本章主要对 SAStudio4 的界面布局、工作模式和常用功能进行说明。 

3.1 工作模式介绍 

海得科技 PX 系列频谱仪提供多种工作模式，主要包括标准频谱分析、IQ 流、检波分析、实时频谱分析、

相位噪声测量和基础数字解调，每种工作模式具备的测量功能将在以下章节进行详细说明。 

3.1.1 标准频谱分析模式（SWP） 

SWP 模式下，仪器根据配置进行跳频以实现频率扫描，该模式适用于面向频率迹线的测量与分析应用。

SWP 模式提供的测量分析功能包括： 

◼ 频谱全景扫描 ◼ IP3/IM3 测试 

◼ 频谱局部放大显示 ◼ 信道功率（Channel Power）测试 

◼ 瀑布图 ◼ 占用带宽（OBW）测试 

◼ 频谱数据记录与回放 ◼ 邻道功率比（ACPR）测试 

◼ 信号追踪 ◼ 峰值表 

3.1.2 IQ 流模式（IQS） 

IQS 模式下，仪器根据指定的触发信号对分析带宽内的时域数据进行采集并返回给用户。IQS 模式适用于

时域信号记录、基础解调分析等应用。IQS 模式提供的功能包括： 

◼ IQ 时域波形图 ◼ IQ 数据的频谱分析 

◼ 瀑布图 ◼ AM/FM 解调 

◼ 功率-时间波形图 ◼ 音频分析 

◼ 多通道数字下变频（DDC） ◼ IQ 数据记录与回放 
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3.1.3 检波分析模式（DET） 

DET 模式下，仪器对分析带宽内的时域信号进行连续的检波分析。DET 模式适用于观察一定带宽内，时间

和功率的关系。例如脉冲参数测量。DET 模式提供的功能包括： 

◼ 功率-时间波形图及缩放图 ◼ 脉冲信号测量波数据记录和回放 

3.1.4 实时频谱分析模式（RTA） 

RTA 模式下，仪器对分析带宽内的时域信号进行实时频谱分析，并将频谱结果返回给用户。RTA 模式适用

于关注瞬时及突发信号的应用，例如干扰排查、复杂电磁环境下特征信号的识别等。RTA 模式提供的功能

包括： 

◼ 实时频谱概率密度图和瀑布图 
◼ 实时频谱数据的记录和回放 

3.1.5 相位噪声测量模式（PNM） 

在相位噪声测量模式下，仪器通过自动化测量技术，提供高精度的相位噪声谱图和详细的数据表。这些测

量结果帮助用户深入分析信号的相位稳定性、噪声分布以及不同频率偏移下的噪声密度。相位噪声测量

模式提供的功能包括： 

◼ 单边带相位噪声谱图 ◼ 相位噪声测量表 

3.1.6 数字解调模式（选件，Beta 版） 

数字解调模式下，仪器对多种调制信号进行解调，并从多个维度分析信号的调制质量。此解调功能适用于

多个应用场景，尤其是在需要对已知调制信号进行深入分析、质量评估及数据提取的环境中。数字解调模

式提供的功能包括： 

◼ 星座图和眼图 ◼ 比特表、解调参数说明 

◼ 调制信号频谱分析 ◼ ASK/FSK/PSK/MSK/QAM 解调 

3.2 界面布局 

SAStudio4 的界面由以下部分组成： 
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◼ 菜单栏（Menu） ◼ 图表设置区（Graph Set Area） 

◼ 图表显示区（Graph Display Area） ◼ 主设置区（Main Setting Area） 

◼ 仪器状态栏（Instrument State） ◼ 参数快捷设置区（Parameter Quick Set） 

 

图 1 SAStudio4 界面布局 

3.2.1 菜单栏 

◼ 保存与载入配置文件 ◼ 设置启动状态 

◼ 工作模式切换 ◼ 测量模式选择 

◼ 单次与连续预览 ◼ 记录与回放 

◼ 快捷截图 ◼ GNSS、仪器信息查看 

3.2.2 图表设置区 

◼ 图表设置 ◼ 迹线操作 

◼ 游标操作 ◼ 显示测量结果 

3.2.3 主设置区 

◼ 测量与分析设置 ◼ 触发设置 
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◼ 数据记录与回放 ◼ 系统设置 

3.2.4 仪器状态栏 

◼ 仪器型号 ◼ 软件与硬件版本 

◼ 仪器实时温度 ◼ 总线数据吞吐量 

◼ GNSS 天线连接状态 ◼ 仪器电量 

3.3 SAStudio4 常用功能介绍 

3.3.1 保存和打开仪器配置 

1）保存当前配置 

1. 点击菜单栏中的“File”，选择“Save State”； 

2. 在“Save Configuration File”弹窗中，设置保存路径和文件名，点击“Confirm”保存配置文件。 

 

2）打开预存配置 

1. 点击菜单栏中的“File”，选择“Recall State”； 

2. 在“Please Select file”弹窗中选择配置文件，点击“Confirm”打开预存配置。 
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3.3.2 设置启动状态 

海得科技 PX 系列频谱仪支持用户进行仪器启动状态设置，所支持的启动状态详情请见表 3。 

表 3 SAStudio4 软件启动状态 

序号 启动状态名称  

1 Default 仪器默认配置 

2 User Preset 选择用户预存的配置文件作为启动的初始配置 

3 Last State 使用上一次退出软件时的参数配置作为启动的初始配置 

若您想进行启动状态设置，请按照以下步骤进行。 

1. 点击菜单栏中的“File”，选择“Power On State”设置软件启动状态; 

2. “Default”和“Last State”直接勾选即可，下一次启动软件时将以该选择作为启动的初始状态; 

3. 选择“User Preset”，在出现的“please Select File”弹窗中选择用户预存的配置文件，然后点击“Confirm”。

下次启动时，软件将以用户指定的配置打开。 
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3.3.3 切换工作模式 

点击菜单栏中的“Mode”，可以将 SAStudio4 的工作模式切换至标准频谱分析模式（SWP）、IQ 流模式

（IQS）、检波分析模式（DET）、实时频谱分析模式（RTA）、相位噪声测量模式（PNM）和数字解调模

式。 

  

3.3.4 保存截图 

1. 点击菜单栏中的“File”，选择“Save Image”； 

2. 在“Save Image”弹窗中，设定图片保存路径和图片名，点击“Confirm”保存截图（未外接外部扩展
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存储器时，图片默认保存在本地，外接存储器后，可选择直接保存至存储器）。用户也可以通过点击菜单

栏中的快捷按键“ ”进行截图。 

 

3.3.5 查看 GNSS 信息 

点击菜单栏中的“System”，选择“GNSS Info”。选择之后出现“GNSS Info”弹窗，弹窗中重点参数说明请

见表 4。 
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表 4 GNSS 参数说明 

序号 参数 说明 

1 Format 提供“本地时间”和“UTC 时间”两种时间格式 

2 Antenna 选择“内部天线”或“外部天线”（目前仅支持外部天线） 

3 SatNum 已定位的卫星数量/可视卫星数量 

4 SNR(Max) 已定位卫星的最大信噪比/未定位卫星的最大信噪比 

5 SNR(Min) 已定位卫星的最小信噪比/未定位卫星的最小信噪比 

6 SNR(Avg) 已定位卫星的平均信噪比/未定位卫星的平均信噪比 

3.3.6 预设 

点击菜单栏中的“Preset”按钮，可以将 SAStudio4 软件配置快速恢复至仪器的默认初始状态。 

 

3.3.7 单次与连续预览 

单次预览：点击“Single”，连续预览：点击“Continue”。 
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3.3.8 快捷记录与回放 

记录：点击菜单栏中的“Rec”，将开始记录数据，点击“stop”停止记录。 

回放：点击菜单栏中的“Play”，回放最近一次的记录数据，点击“Pause”暂停回放。 

点击菜单栏的“Continue”按钮，可以恢复正常的数据采集和显示。 
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3.3.9 专业和简洁设置 

点击菜单栏中的“System”菜单，在下拉菜单中点击“Setting Mode”，即可在“Basic”或“Professional”

模式之间进行切换。专业模式相比简洁模式，在主设置区提供更全面的参数选项，用户可以根据自身的使

用需求，灵活选择合适的设置模式。 

 

3.3.10 隐藏面板 

点击菜单栏中的隐藏图标“ ”，隐藏主设置区菜单，增大显示区域。 
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3.3.11 查看当前仪器信息 

点击菜单栏中的“System”，选择下拉菜单中“About”，当前仪器信息将于“About”弹窗中显示。 

 

3.3.12 游标功能 

游标功能主要在图表设置区的“游标”子菜单下进行设置，除此之外，SAStudio4 中还提供了游标的一些

快捷使用方法，本节将详细说明 SAStudio4 中游标的使用方法。 

1） 创建游标 

1. 创建单个游标 

双击图表显示区或点击图表设置区“Peak Search”按钮可快速唤出参考游标。 

2. 创建多个游标 

点击图表设置区的“Marker”子菜单，选择需要创建的游标，然后点击“Enabled”启用所选游标。 
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2） 创建游标对 

点击图表设置区“Graph”，在弹窗中选择“Marker Pair”，快速启用一对参考游标和差值游标， 

连续点击，启用多对游标（当前上限 5 组）。 

 

3） 关闭游标 

1. 关闭单个游标 

点击图表设置区的“Marker”子菜单，选择需关闭的游标，然后点击“Enabled”即可关闭所选游标。 
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2. 关闭所有游标 

点击图表设置区“Graph”，在弹窗中选择“Clear All”，关闭所有游标。 

 

4） 游标寻峰 

1. 局部寻峰 

在局部峰值附近双击图表，或者选中游标后点击“Marker”→“Local Peak”，即可开启局部寻峰。 
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2. 全局寻峰 

点击“Peak Search”即可开启全局寻峰。 

 

5） 差值游标 

差值游标要与参考游标一起使用，表示与参考游标之间的频率差、时间差和幅度差。 
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6） 噪声密度 

创建游标之后，在图表设置区的“Marker”中打开“NoiseDensity”，可以将原先的功率值转换为每赫兹的

功率密度。 

 

7） 游标至中心 
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将参考游标移动到目标频率位置后，点击图表设置区“Marker”中的“to Center”，将游标所在的频率对

齐到中心位置。 

 

8） 游标至模式 

将参考游标移动到目标频率位置后，点击图表设置区“Marker”选项中的“Switch To”按钮，即可快速切

换其他工作模式，并将当前游标位置的频率值设为新模式的中心频率。 
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3.3.13 瀑布图 

仅 SWP 模式、IQS 模式和 RTA 模式支持瀑布图功能。点击瀑布图-Graph 图表区设置，可进入瀑布图设置，

瀑布图部分控件介绍如下表所示： 

表 5 瀑布图控件介绍 

图表设置区 

Scan Depth 控制瀑布图 y 轴上缓存的时间长度 

Time Density 控制瀑布图刷新速度 

ColorGradation 设置瀑布图色阶 

点击“Graph”按钮，在弹出的菜单中选择“Spectrogram”即可启用瀑布图显示。 

 

3.3.14 局部放大图 

1） 频谱放大图（仅 SWP 模式） 

1. 点击“Graph”，在弹出的子菜单中打开“Zoom”; 

2. 点击选中频谱放大图，点击“Graph”，在弹出的子菜单中设置需要放大的频率范围。 
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2）时域放大图（仅 IQvT、PvT 和 DET 模式） 

1. IQvT 和 PvT 

IQS 模式下，点击主设置区“IQvT”或“PvT”，选择相应通道，打开“Analyze”和“Zoom”，通过按住

缩放区域滑动缩放框、按住缩放边框左右拖动的方式调整缩放区域。 

 

2. DET 模式 
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1．点击“Graph”，在弹出的子菜单中打开“Zoom”; 

2．按住缩放区域滑动缩放框、按住缩放边框左右拖动、选中缩放图“PvT Zoom”，点击“Graph”，设置

“TimeCenter”和“TimeRange”。均可调整缩放区域。 

 

3.3.15 记录与回放 

记录与回放功能重要参数说明请参见表 6。 

表 6 记录与回放参数说明 

记录  

RecordMode 

固定时长：可预设记录点数、记录时长及文件大小限制（注意：实际记录文件

的大小不得超过硬盘剩余容量） 

手动模式：需手动控制记录文件的记录时长（注意：在手动模式下，当记录文

件大小超过单次文件大小限制时，软件将自动停止记录） 

RecordTime 设置记录时长，仅记录模式为“固定时长”时生效 

FileSizeLimit 单个记录文件的存储大小限制 

Disk 硬盘剩余容量和硬盘总容量 

回放  

Last frame 回退一帧 
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Next frame 前进一帧 

Back 回退若干帧 

Forward 前进若干帧 

1）数据记录 

点击主设置区“Record”，再点击子菜单“RecordMode”选择记录模式。 

点击“REC File Path”设置记录文件的存放路径，默认存放路径为“../userdata/SAStudio4/data”。用户可

以自定义存储路径，如果外接存储器，则可以选择将记录文件存储在外接设备上。 

 

固定时长模式下，点击“Record on”，自动记录预设大小的数据。自适配模式下，通过点击“Record on”

和“Record off”，手动控制记录时长，当记录文件大小超过文件大小限制时，自动停止记录。 

2）数据的回放 

点击主设置区“Play Back“下的“Open File”按钮，在弹窗中选择需要回放的记录文件，然后点击“Confirm”。 

点击“Play Back”开始回放、点击“Pause”停止回放、点击“Stop”退出回放界面恢复数据获取，设置

“PlaybackRate”的值可以调节回放的速率，打开“Auto Loop”将循环回放该记录文件。 
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3.3.16 导出数据 

（1）在需要导出数据的图表设置区（例如下图中的频谱图表区），点击“Graph”菜单，在弹出的子菜单

中选择“DataExport”。其中，“image”选项可以将当前图表导出为 PNG 图片文件，“Data”则将图表

数据导出为 CSV 文件； 

 

（2）在“Save”弹窗中，设定数据保存路径和数据名，点击“Confirm”保存图片/CSV 文件（未外接外部

扩展存储器时，默认保存在本地，外接存储器后，可选择直接保存至存储器）； 
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（3）PX 系列仪器默认将数据存储在：桌面“userdata“→“SAStudio4_x.xx.xx“下的 images（图表图片）、

data（记录文件和配置文件）、reports（图表数据 CSV 文件和相应的配置文件）文件夹中； 

 

3.3.17 删除文件与图像 

1、点击“File”→“Exit”退出 SAStudio4 运行界面； 

2、进入“userdata“→”SAStudio4_x.xx.xx”→“images”，将图片拖放至“Trash Can”，并在 Confirm 弹

窗中点击“Yes”，即可删除截图（记录文件和配置文件删除与截图删除方式一致）。 
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3.3.18 采样率修改 

IQS 模式下，点击主设置区”BW”，修改子菜单中“IQSampleRate”的值可以修改仪器的采样率。 

 

3.3.19 快捷参数设置 

快捷参数设置目前支持：参考电平、RBW、VBW、检波器、起始频率、终止频率、扫宽、中心频率等频谱

分析常用参数进行快速设置。 
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4. SWP 模式的使用 

本章节着重介绍 SWP 模式的部分重要参数和测试方法。 

4.1 SWP 模式通用参数介绍 

SWP 模式部分重要参数说明如表 7 所示。 

表 7 SWP 模式参数说明 

Frequency 
 

本振优化 

自动：默认低杂散模式 

扫描速度：高扫速模式 

杂散：低杂散模式 

相位噪声：低相噪模式 

Amplitude  

预放 

设置前置放大器动作： 

自动使能：当参考电平低于-30 dBm 左右时，前置放大器开启 

强制关闭：任何参考电平下总保持放大器关闭 

增益策略 
低噪声：侧重低噪声并保持噪底平整 

高线性度：侧重高线性度并保持噪底平整 

中频增益档位 

0-X 档 每档差 3 dB 增益 

提高中频增益挡位：射频增益减小，底噪升高，线性度提升，杂散减少 

降低中频增益挡位：射频增益增加，底噪变低，线性度变差，杂散增多 

衰减 

0-33 dB（不同频段的衰减上限不同），步进为 1 dB 

Atten = -1 dB（默认）：不开衰减 

Atten ≥ 0dB 时：开启衰减，此时参考电平=衰减值-10 

Sweep  

扫描时间模式 

minSWT：以最短扫描时间进行扫描 

minSWTx2：以近似 2 倍最短扫描时间进行扫描 

minSWTx4：以近似 4 倍最短扫描时间进行扫描 

minSWTx10：以近似 10 倍最短扫描时间进行扫描 

minSWTx20：以近似 20 倍最短扫描时间进行扫描 

minSWTx50：以近似 50 倍最短扫描时间进行扫描 

minSWTxN：以近似 N 倍最短扫描时间扫描，N 等于扫描时间倍数 

手动：以近似指定的扫描时间进行扫描，扫描时间等于 SweepTime。 

迹线点数策略 
扫描速度优先：优先保证扫描速度最快，尽量靠近设置的目标迹线点数 

点数准确优先：优先保证接近设置的目标迹线点数 

杂散抑制 无杂散优化、标准杂散优化、增强杂散优化。 
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FFT 执行 

自动：根据设置自动选择使用 CPU 还是 FPGA 进行 FFT 计算（RBW 在

40kHz 以下为 CPU 计算，以上为 FPGA 计算）、CPU 优先、FPGA 优先、

CPU 计算-低资源占用、CPU 计算-中资源占用、CPU 计算-高资源占用、

FPGA 计算 

窗型 

FlatTop 窗：更高的幅度准确度 

B-Nuttal 窗：更高的频率选择性 

LowSideLobe 窗：更高的低频信号的测量准确性 

4.2 信道功率 

以测试载波频率 1 GHz、功率-20 dBm 和 1 MHz 符号率的 BPSK 信号为例。 

4.2.1 参数说明 

此处仅对部分重要参数进行说明：信道功率测量部分重要参数如表 8 所示。 

表 8 信道功率测量参数说明 

Channel Power  

Meas BW 设置待测信道的带宽，信道功率为该带宽内的积分功率 

Span Power 将测量带宽设置为当前扫宽（Span），计算该范围内的信道功率 

4.2.2 操作步骤 

1. 将中心频率设置为1 GHz，参考电平设置为0 dBm，点击“Meas”菜单，选择子菜单中的“ChannelPower”； 

2. SAStudio4 将自动配置默认参数，测试结果如下图所示。测量方框左上角为信道功率值。在下侧

“Channel Power”栏中也可查看测量带宽、信道功率、功率谱密度值； 



 

海得科技 PX 系列用户指南 32 

 

3. 您也可自行调整：信道中心频率（按住测量区域滑动选择）和测量带宽（按住测量边框左右拖动或

调整 Meas BW 设置）。 

4.3 占用带宽 

以测试载波频率 1 GHz、功率-20 dBm 和 1 MHz 符号率的 BPSK 信号为例。 

4.3.1 参数说明 

此处仅对部分重要参数进行说明：占用带宽测量部分重要参数如表 9 所示。 

表 9 占用带宽测量参数说明 

占用带宽测量参数 

Method XdB、百分比 

XdB/Percent 设置具体的 XdB 值/百分比 

4.3.2 操作步骤 

1. 将中心频率设置为 1 GHz，参考电平设置为 0 dBm，点击“Meas”菜单，选择子菜单中的“OBW”； 

2. SAStudio4 将自动配置测量参数，测量结果如图所示。在下侧“OBW”栏中可查看占用带宽值。 
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4.4 邻道功率比 

以测试载波频率 1 GHz、功率-20 dBm 和 1 MHz 符号率的 BPSK 信号为例。 

4.4.1 参数说明 

此处仅对部分重要参数进行说明：邻道功率比测量部分重要参数如表 10 所示。 

表 10 邻道功率比测量参数说明 

ACPR 

Space 设置主信道与邻道的频率间隔 

Count 设置邻道对的数量 

Main Power 主信道的功率 

Adj Center 邻道的中心频率 

Adj Power 邻道功率测量值 

Adj Ratio 邻道功率比测量值 

4.4.2 操作步骤 

1. 将中心频率设置为 1 GHz，参考电平设置为 0 dBm，点击“Meas”菜单，选择子菜单中的“ACPR”； 

2. SAStudio4 将自动配置默认参数，测试结果如下图所示。其中绿色信道带宽顶部为各信道功率值。下

侧“ACPR”栏中也可查看邻道中心频率、邻道功率和邻道功率比。 
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3. 您也可自行设置主信道的中心频率、各信道带宽、邻道间隔和邻道对数。 

 

4.5 IP3/IM3 

以测试 1 GHz 频点的 IP3/IM3 为例。 

4.5.1 参数说明 

此处仅对部分重要参数进行说明：IP3/IM3 测量部分重要参数如表 11 所示。 

表 11 IP3/IM3 测量参数说明 

IP3/IM3 

LowToneFreq 输入的低频信号的频率 

LowTonePower 输入的低频信号的功率 

HighToneFreq 输入的高频信号的频率 

HighTonePower 输入的高频信号的功率 

LowIM3PFreq 低侧交调频率 

LowIM3P 低侧交调功率 

HighIM3PFreq 高侧交调频 

HighIM3P 高侧交调功率 

TonePowerDiff 高低频信号功率差 
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4.5.2 操作步骤 

1. 通过两台信号源和合路器，将中心频率为 999 MHz，幅度为 0 dBm 和中心频率为 1.001 GHz，幅度为

0 dBm 信号合并成一路信号，输入频谱仪； 

2. 将频谱仪中心频率设置为 1 GHz，参考电平设置为 0 dBm，点击“Meas”菜单，选择子菜单中的“IM3”； 

3. 调整信号功率，使信号功率在频谱图中显示为低于参考电平 6 dB 左右； 

4. SAStudio4 将自动配置默认参数，下图为测试结果。在下方“IM3”栏中可查看 IP3 测试结果。 

  

4.6 频率追踪 

1. 点击图表设置区“Marker”，在弹出的子菜单中，点击“More”，再点击“Advanced”,设置追踪信号

的峰值门限以及抖动范围（峰值频率在此范围内抖动的时候，不频繁将此时的频率值对齐到中心位置）； 
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2. 点击“Signal Track”，参考游标在此时的扫宽内进行寻峰，并将此时的峰值信号对齐到中心频率位置，

当目标信号的频率发生漂移时，频谱仪会自动调整自身的中心频率，使信号始终位于图表显示区的中心

区域，方便用户观察和分析。 

 

注：一般情况下该功能，只移动频率位置，不改变扫宽。但对于漂移幅度特别大，超出当前扫宽的信号，

难以继续跟踪；对于处在仪器扫描范围边缘的信号，因为频率限制，会进一步减小扫宽。 
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4.7 峰值表 

1. 点击图表设置区“Marker”，在弹出的子菜单中点击“More”，再点击“Advanced”,设置峰值表的门

限值，详细设置说明请见频率追踪章节； 

2. 点击“Peak Table”，频谱仪将自动在当前扫宽范围内检测并标注超过门限的峰值点（上限 10 个），并

在显示区下方的峰值表内，按峰值信号功率从大到小的顺序显示每个峰值的频率和功率信息，方便用户

快速查看频谱内的主要信号。 
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5. IQS 模式的使用 

本章详细介绍了 IQS模式的部分重要参数，着重描述了如何对系统获取的时域 IQ数据展开进一步的分析，

如频谱分析、时域分析、功率时间分析、数字下变频、解调等。 

5.1 IQS 通用参数介绍 

表 12 IQS 模式参数说明 

Frequency 

本振优化 请参见 SWP 通用参数介绍同名参数 

BW 

原生采样率 ADC 采样率，可设置 110 MSa/s~130 MSa/s 

分析带宽 显示抽取后的等效采样率：ADC 采样率/抽取倍数 

数据格式 

8bit：精度较低，无信号时容易获取到很多 0，支持 2 抽取及以上连续流

获取 

16bit：默认配置，支持 4 抽取及以上的连续流获取 

32bit：精度较高，支持 8 抽取及以上的连续流获取 

Amplitude 

预放 

请参见 SWP 通用参数介绍同名参数 
增益策略 

中频增益档位 

衰减 

Record 

RecordMode 

请参见记录与回放同名参数 
RecordTime 

FileSizeLimit 

Disk 

Playback 

Last frame 

请参见记录与回放同名参数 
Next frame 

Back 

Forward 
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5.2 IQS 模式功能简介 

IQS 模式的初始界面如下图所示，由最大功率时间缩略图、频谱图和时域图组成。点击主设置区的“Next”，

再点击“Trigger”，修改子菜单中“PreviewTime”的值可以改变最大时间缩略图中 IQ 流的预览时间。 

频谱图和 IQ 时域图分别由最大功率时间缩略图中的“Spectrum-P”和“IQvT-P”红色缩选框所决定，改变

选择范围，可观察不同时间段的 IQ 时域信号，也可对不同时间段采集的 IQ 时域信号进行频谱分析。 

 

5.3 频谱分析 

5.3.1 参数说明 

此处仅对部分重要参数进行说明：频谱分析部分重要参数如表 13 所示。 

表 13 频谱分析部分参数说明 

频谱分析子菜单 

窗型 参见 SWP 模式通用参数介绍同名参数 

频谱截取 
频谱截取：如 Intercept = 0.8，显示 80%的 FFT 频谱分析结果，以便将过渡带

频谱成分截取 

5.3.2 操作步骤 

1. 点击主设置区“FFT”，开启“Analyze”，拖动最大功率时间缩略图中的“Spectrum-P”红色缩选框，
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或调整“TimeStart”和“TimeLength”的值，可以对不同时间段采集的 IQ 信号进行频谱分析，调整“Frequency”

子菜单中“Center”、“BW”子菜单中“Span”的值，可以改变频谱的中心频率和分析带宽； 

2. 通过“FFTsize”，设置频谱分析的点数、“Window”设置不同的窗函数、“TraceDetector”设置不同的

迹线检波器、“Intercept”对频谱进行截取显示，当 Intercept =0.8 时，可以对过渡带进行截取。 

 

5.4 IQvT 

5.4.1 操作步骤 

点击主设置区“IQvT”，开启“Analyze”，拖动最大功率时间缩略图中的“IQvT-P”红色缩选框，或调整

“TimeStart”和“TimeLength”的值，可以对不同时间段的 IQ 信号进行时域分析。 
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5.5 PvT 

5.5.1 操作步骤 

点击主设置区“PvT”，开启“Analyze”，拖动最大功率时间缩略图中的“PvT-P”红色缩选框，或调整“TimeStart”

和“TimeLength”的值，可以对不同时间段 IQ 信号进行功率时间分析； 

 

5.6 AM 解调 

以解调载波频率 1 GHz、功率-20 dBm、调制率 3 kHz、调制深度 70%的 AM 信号为例。 
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5.6.1 参数说明 

此处仅对部分重要参数进行说明：AM 解调部分重要参数如表 14 所示。 

表 14 AM 解调参数说明 

滤波子菜单 

n 滤波器抽头数，抽头数越大滤波器过渡带越陡峭，通带波纹越小 

Fc 截止频率，0<Fc<0.5，例如为 0.25 时，则对一半的带宽进行低通滤波 

As 阻带衰减，阻带衰减越大，对阻带的抑制效果越强，按 dB 进行衰减 

mu 分数采样偏移，推荐使用默认值即可 

5.6.2 操作步骤 

1. 设置“Center”为 1.0001 GHz，调整最大功率时间缩略图中“IQvT-P”的范围，选中 IQ 时域图，点击

“Graph”，选择 Graph 子菜单中的“Auto Range”； 

2. 点击主设置区“Demod”，将下级菜单中“Type”设置为 AM，选中 AM 解调时域图，点击“Graph”

控件下的“Auto Range”； 

3. 点击主设置区“BW”，增大下级菜单中的“Span”以调整分析带宽，本例将分析带宽设置为 15.36 MHz。 

 

5.6.3 音频分析 

可用于测试仪器的解调灵敏度。 
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1. 参考 AM 解调章节 解调 AM 信号； 

2. 点击主设置区“Demod”，打开下级菜单中的“AudioAnalysis”，启用音频分析，查看音频分析的频率

是否与调制率相同，也可以测试信号的信纳德和总谐波失真。 

 

5.7 FM 解调 

以解调载波频率 1 GHz、功率-20 dBm、调制频率 5 kHz 和频率偏移 75 kHz 的 FM 信号为例。 

5.7.1 参数说明 

请参考 AM 解调参数说明章节。收听 FM 广播信号时，可对 FM 解调后的信号进行低通滤波，减少部分高

频噪声，使收听的声音更纯净。 

5.7.2 操作步骤 

1. 设置“Center”为 1 GHz，调整最大功率时间缩略图中“IQvT-P”的范围，选中 IQ 时域图，点击“Graph”，

选择 Graph 子菜单中的“Auto Range”； 

2. 点击主设置区“Demod”，将下级菜单中“Type”设置为 FM，选中 FM 解调时域图，点击“Graph”

控件下的“Auto Range”； 

3. 点击主设置区“BW”，增大下级菜单中的“Span”以调整分析带宽，本例将分析带宽设置为 7.68 MHz。 
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5.7.3 音频分析 

解调 FM 信号后，请参考音频分析 章节对解调后的信号进行音频分析，分析结果如下所示： 

 

5.8 DDC 数字下变频 

对 IQ 数据流进行数字下变频与重采样生成子 IQ 流，进行进一步的频谱分析。下面以频率 1 GHz、功率-20 

dBm 单音信号的 DDC 为例。 
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5.8.1 参数说明 

此处仅对部分重要参数进行说明：DDC 数字下变频部分重要参数如表 15 所示。 

表 15 DDC 数字下变频参数说明 

采样子菜单 

OffsetFreq 复混频的频率偏移，>0 时，频谱向右搬移；<0 时，频谱向左搬移 

Decimate 设置 DDC 的抽取倍数，即重采样率 

5.8.2 操作步骤 

1. 设置“Center”为 1 GHz，“Ref.Level”为 0 dBm，调整最大功率时间缩略图中“IQvT-P”的范围，选中

IQ 时域图，点击“Graph”，选择 Graph 子菜单中的“Auto Range”； 

2. 点击主设置区“DDC”，打开“Channel1”，并设置 DDC1 通道的“Center”为 1.003 GHz，“OffsetFreq”

为-3 MHz，“Step”为 1 MHz，“Decimate”为 3； 

 

3. 点击主设置区“FFT”，在下拉菜单中选择“DDC1 Channel”，打开“Analyze”，拖动最大功率时间缩略

图中的“Spectrum-D1”红色缩选框，或调整“TimeStart”和“TimeLength”的值，可以对不同时间段 DDC

生成的 IQ 子流进行频谱分析； 
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4. 点击主设置区“IQvT”，在下拉菜单中选择“DDC1 Channel”，打开“Analyze”，拖动最大功率时间缩

略图中的“IQvT-D1”红色缩选框，或调整“TimeStart”和“TimeLength”的值，可以对不同时间段 DDC 生

成的 IQ 子流进行时域分析； 

 

5. 点击主设置区“PvT”，在下拉菜单中选择“DDC1 Channel”，打开“Analyze”，拖动最大功率时间缩略

图中的“PvT-D1”红色缩选框，或调整“TimeStart”和“TimeLength”的值，可以对不同时间段 DDC 生成
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的 IQ 子流进行功率-时间分析。 
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6. DET 模式的使用 

本章详细介绍部分 DET 模式的参数以及该模式下脉冲信号的测量。 

6.1 DET 通用参数介绍 

此处仅对部分重要参数进行说明：DET 模式部分重要参数如表 16 所示。 

表 16 DET 模式参数说明 

Frequency 

本振优化 请参见 SWP 通用参数介绍同名参数 

Amplitude  

预放 

请参见 SWP 通用参数介绍同名参数 

增益策略 

中频增益挡位 

衰减 

6.2 脉冲信号测量 

以测试载波频率 1 GHz、功率-10 dBm、脉冲周期为 80 us 和脉宽为 40 us 的脉冲调制信号为例。 

6.2.1 操作步骤 

1. 将“Center”设置为 1 GHz，点击菜单栏“Single”，开启单次预览模式； 

2. 点击图表设置区的 Graph，点击“Zoom”，打开缩放，调整缩放区域（按住选中缩放区域滑动缩放框、

按住缩放边框左右拖动）； 

3. 选中缩放图，点击图表设置区的“Graph”，选择“Marker Pair”创建两组游标对，将 M1R 游标移至

脉冲上升沿处，M1D 移至同一脉冲下降沿处，M2R 移至脉冲上升沿处，M2D 移植至下一脉冲上升沿处。

此时在缩放图左上角 M1D 游标和 M2D 游标的显示结果分别为脉冲信号的脉宽、脉冲周期，可根据以下

公式计算出占空比。 

占空比 =
脉宽

脉冲周期
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6.3 脉冲信号检测（选件） 

本章介绍脉冲信号检测的基本操作方法，以及后期补购脉冲检测选件的客户如何获取和放置许可证。 

6.3.1 申请许可证 

如果您购买设备时已包含脉冲检测选件，可忽略本章节内容。若您后期补购脉冲检测选件，请按照以下步

骤获取并放置脉冲检测许可证，以便正常使用该功能。 

1. 点击菜单栏中的“System”，选择下拉菜单中“About”，查看弹窗中的版本信息； 
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2. 确保版本达到以下要求； 

▪ GUI 版本：4.3.55.6 或以上 

▪ API 版本：0.55.55 或以上 

▪ FPGA 版本：0.55.15 或以上 

▪ MCU 版本：0.55.32 或以上 

3. 若软固件版本未达到上述要求，请参考软固件更新节更新软固件至所需版本； 

4. 软固件更新至所需版本后，将整个界面的截图发送至海得科技官方技术支持，以申请相应设备的脉

冲检测许可证。所需界面示意图如下： 

 

5. 点击“File”→“Exit”退出 SAStudio4 运行界面； 

6. 将技术支持处获取到的许可证拷贝至 U 盘中，之后将 U 盘连接至仪器上面板的 USB 端口，并在弹出

的“Removable medium is inserted”弹窗中点击“OK”； 

7. 将 U 盘中的脉冲检测许可证通过拖放的方式复制至桌面； 
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8. 进入“userdata”→“SAStudio4_x.xx.xx”→“bin”→“CalFile”，将脉冲检测许可证文件拖放至“CalFile”

文件夹中； 

 

9. 关闭弹窗并启动 SAStudio4 软件，点击菜单栏“Mode”，选择“Power Detection”进入检波分析模式，

启用主设置区“Pulse Det”，即可正常使用脉冲信号检测功能。 
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6.3.2 参数说明 

此处仅对部分重要参数进行说明：脉冲信号检测部分重要参数如表 14 所示。 

表格 17 脉冲信号检测参数说明 

Pulse Det 

阈值 脉冲检测门限，大于该门限值的脉冲信号才会被判定为有效脉冲 

最大脉冲数量 当前预览时间下脉冲信号检测上限 

6.3.3 操作步骤 

以 1 GHz，-20 dBm，脉宽 40 us，脉冲周期 80 us 的脉冲信号的检测为例。 

1. 将“Center”设置为 1 GHz，“Ref.Level”设置为 0 dBm； 

2. 点击主设置区“BW”，调整附加菜单中“BW”的值设置不同的分析带宽，本例中将“AnalysisBW”设

置为 62.5 MHz； 
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3. 点击主设置区“Trigger”，将“PreviewTime”设置为 500us； 

 

4. 点击主设置区“Pulse Det”，启用脉冲检测功能。拖动功率时间图中的“Trigger.Level”的值，设置脉

冲检测阈值，调整“MaxPulseCount”的值，设置当前预览时间下脉冲信号检测上限； 
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5. 点击菜单栏“Single”，当前配置下的脉冲检测结果如下图所示。从图中可以得到每个检测到脉冲信号

的峰值电平（dBm）、基准电平（dBm）、上升时间、上升沿、下降时间、下降沿、脉宽、周期和占空比等

参数。以及所检测到脉冲信号的统计参数，如：最大、最小、平均脉冲周期和脉宽、周期偏差百分比和脉

宽偏差百分比。 

 

6. 若用户在使用脉冲检测的过程中，出现测量冻结/停止的状态，可通过调小分析带宽、调大脉冲周期

等方式避免此类现象。 
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7. RTA 模式的使用 

本章详细介绍了 RTA 模式的部分参数、概率密度图的关闭以及该模式下 WIFI 信号的测量。 

7.1 RTA 通用参数介绍 

此处仅对部分重要参数进行说明：RTA 模式部分重要参数如表 18 所示。 

表 18 RTA 模式参数说明 

Frequency 

本振优化 请参见 SWP 通用参数介绍同名参数 

Amplitude 

预放 

请参见 SWP 通用参数介绍同名参数 
增益策略 

中频增益档位 

衰减 

Sweep 

扫描时间模式 

请参见 SWP 通用参数介绍同名参数 

窗型 

7.2 概率密度图 

7.2.1 参数说明 

Graph 

概率图 On：启用概率密度图显示 

Off：关闭概率密度图显示 

色阶 天空色、深海色（默认）、喷射色、冷度色、热度色、灰度色 

余晖 增大：延长信号残影显示时间，适合捕捉突发信号 

减小：加快刷新速度，适合追踪持续信号 

7.2.2 关闭概率密度图 

点击图表设置区“Graph”，在弹窗中关闭“BitMap”，即可关闭概率密度图。 



 

海得科技 PX 系列用户指南 56 

 

7.3 WIFI 信号测量 

1. 将天线连接至射频输入端口“RFIN”； 

2. 将“Center”设置为 2.44 GHz，增大图表设置区“Graph”子菜单下的“Afterglow”余晖值，即可更

明显的观测 WIFI 信号。 
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8. 数字解调（选件，Beta 版） 

本章介绍数字解调的基本操作方法，以及客户如何通过许可证的方式启用数字解调功能。 

8.1 申请许可证 

如果您购买设备时已包含数字解调选件，可忽略本章节内容。若您后期补购数字解调选件，请按照以下步

骤获取并放置数字解调许可证，以便正常使用该功能。 

1. 参考脉冲信号检测申请许可证章节，申请相应设备数字解调许可证，并将其放至“CalFile”文件夹中； 

2. 关闭弹窗并启动 SAStudio4 软件，点击菜单栏“Mode”，选择“Digital Demod”，即可正常使用数字解

调功能。 

 

8.2 参数说明 

此处仅对部分重要参数进行说明：部分重要参数如表 14 所示。 

表格 19 数字解调参数说明 

Digital Demod  

符号率 信号每秒传输的符号数量，需按照调制信号的符号率填写，以确保接收

端能够正确解调 

模式 AM、FM、PM、CW、LSB、USB、2ASK、2FSK、4FSK、BPSK、QPSK、

16QAM、64QAM 
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滤波滚降系数 用于限制信号带宽的滤波器在过渡带的滚降速率，需与发射端的滚降系

数保持一致，以确保解调器对信号的有效处理和正确解调 

8.3 功能简介 

数字模式的初始界面如下图所示，由调制信号频谱图、解调后的星座图、眼图和解调参数组成，深入分析

信号的调制质量，提供多项误差指标，有效评估信号在传输中的完整性和可靠性。 

 

8.4 操作步骤 

以解调 1 GHz，-20 dBm，符号率 100 kHz，滤波滚降系数 0.35 的 64QAM 信号为例。 

1. 将“Center“设置为 1 GHz，“RefLevel”设置为 0 dBm； 

2. 点击主设置区“Demod”，将附加菜单中“ModType”设置为 QAM64，“SymbolRate”设置为 100 KSPS，

“FilterType”设置为 0.35，点击菜单栏“Single”，当前配置下解调结果如下图所示。星座图中星座点清晰

且分布紧密，理论与实际解调点位置基本重合，说明信号的调制质量高，通信系统的整体性能较好；眼图

清晰且开口较大，说明码间干扰较小，接收端能够可靠地区分符号；与此同时还能得到误差矢量幅度

（EVM）、幅度误差、相位误差、频率误差、信噪比（SNR/MER），以及部分解码后的比特序列。 



 

海得科技 PX 系列用户指南 59 
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9. 相位噪声测量模式 

9.1 版本要求 

1. 点击菜单栏中的“System”，选择下拉菜单中“About”，查看弹窗中的版本信息。 

 

2. 确保版本达到以下要求 

▪ GUI 版本：4.3.55.12 或以上 

▪ API 版本：0.55.58 或以上 

▪ FPGA 版本：0.55.17 或以上 

▪ MCU 版本：0.55.49 或以上 

3. 若软固件版本未达到上述要求，请参考软固件更新章节更新软固件至所需版本。 

9.2 启用相位噪声测量功能 

软固件更新至所需版本之后，重新启动 SAStudio4 软件，点击菜单栏“Mode”，选择“Phase Noise”即可

正常使用相位噪声测量功能。 
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9.3 参数说明 

此处仅对部分重要参数进行说明：相位噪声测量部分重要参数如表格 20 所示。 

表格 20 相位噪声测量模式参数说明 

Frequency  

起始频偏 设置频率偏移的起始点，范围：1~10 MHz 

终止频偏 设置频率偏移的终止点，范围：10~10 MHz 

载波识别门限 设置载波识别门限，高于该门限的载波才会被识别 

搜索载波 全频段搜索定位高于载波识别门限的信号 

Meas  

RBW/Offset RBW 比例（各频率分段 RBW/各频率分段的起始频率），范围：0.01~0.3 

检波设置 
帧检波率：推荐使用默认配置，若待测信号近端存在明显的低频抖动，

可增大近端的帧检波率，获取更稳定的测量结果 

Trace  

平均 设置迹线平均的次数 

平滑 
开启：启用迹线平滑功能 

关闭：关闭迹线平滑功能 

窗长度 设定平滑算法的窗口长度，范围：0~10% 

9.4 操作步骤 

9.4.1 已知载波信息的相位噪声测量 

以测量 1 GHz，0 dBm 信号在 100 Hz 至 10 MHz 偏移范围内的相位噪声为例。 
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1. 点击主设置区“Frequency”，在附加菜单中将“中心频率”设置为 1 GHz，“起始频偏”设置为 100 Hz，

“终止频偏”设置为 10 MHz，其余参数推荐使用默认配置； 

 

2. 若待测信号近端存在较强抖动，可点击主设置区“Meas”，然后在附加菜单中选择“检波设置”，在

弹出的窗中，适当增大对应频段的帧检波率，获得更收敛的测量结果； 

 

3. 若单边带相位噪声谱图中存在较明显的杂散，可点击主设置区“Trace”，然后在附加菜单中选择“窗

长度”，逐步增大其参数值，以减小杂散对测量结果的干扰； 
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4. 仪器将自动完成设定频偏范围内的相位噪声测量，测量结果如下所示。在界面下方的相噪测量表中，

可以得到载波的信息以及各特征频偏点的相位噪声值（单位：dBc/Hz）。 

 

9.4.2 未知载波信息的相位噪声测量 

当信号载波参数未知时，建议按照以下流程进行相位噪声测量。（假定此时未知的载波信号为 2 GHz，-10 

dBm） 

1. 点击“搜索载波”，仪器将自动进行全频段扫描，搜索并定位超过载波门限的峰值信号作为待测载波； 
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2. 定位到载波信号后，可参考已知载波信息的相位噪声测量章节，设置起始频偏和终止频偏，进行相

噪测量。 
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10. 其他功能的使用 

本章简要介绍了仪器的中频输出以及触发功能，详细介绍了如何使用 GNSS 模块、输入外部参考时钟和对

设备进行远程控制。 

10.1 GNSS 使用说明 

10.1.1 连接 GNSS 天线 

连接天线和 MMCX 转 SMA 连接线，并将 MMCX 端连接至仪器的 GA 接口（使用外部 GNSS 天线时，请将

天线的接收面朝向无遮挡的天空）。 

 

10.1.2 查看 GNSS 信息 

1. 打开 SAStudio4，点击“System”，选择“GNSS Info”，在 GNSS Info 框中将天线类型切换为

“GNSS_AntennaExternal”； 

2. 等待 1-3 分钟后 GNSS 即可锁定，可以根据状态栏信息中 GNSS 锁定标识判断 GNSS 锁定与否，锁定

后 GNSS 锁定标志标为绿色，若为灰色则未锁定。 
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10.1.3 使用 GNSS 模块的 1PPS 触发 

仅 IQS 模式、DET 模式和 RTA 模式下可使用外部 GNSS 模块的 1PPS 触发。本节将以 IQS 模式为例，详细

说明如何配置 GNSS 模块的 1PPS 触发功能。 

1. 请参考连接 GNSS 天线章节正确连接仪器与天线； 

2. 请参考查看 GNSS 信息章节确保 GNSS 已锁定； 

3. 点击“Mode”，选择“IQStreaming”，切换至 IQS 模式； 

4. 点击主设置区“Trigger”子菜单，将触发源设置为“GNSS-1PPS”使用 GNSS 模块的 1PPS 触发。 
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10.1.4 GNSS 使用注意事项 

GNSS 模块未锁定时，不建议使用 GNSS 的 1PPS 和 10MHz 时钟信号输出。 

10.2 触发功能介绍 

10.2.1 SWP 扫频模式 

触发输入 

触发源 扫描模式触发源：自由运行、外部-触发帧、外部-触发扫描、外部-触发配置 

触发边沿 上升沿、下降沿、双边沿 

触发输出 

触发输出 

无触发 

跳频触发：每完成一帧分析输出一个触发 

扫描触发：每完成一次迹线扫描输出一个触发 

配置触发：每切换一次配置输出一个触发 

触发输出脉冲极性 正脉冲、负脉冲 

10.2.2 IQS、DET、RTA 定频点模式 

触发输入 
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触发源 

定频点模式触发源：外部触发、总线触发、电平触发、定时器触发、多

机同步触发、GNSS-1PPS 触发和 GNSS-1PPS 多机同步触发 

触发边沿 上升沿、下降沿、双边沿 

触发延迟 设置触发之后，延迟采集的时间 

预触发 设置触发之前，提前采集的时间 

重触发 仪器在捕捉到一次触发后，多次响应 

重触发次数 单次触发响应后，额外需要做几次响应 

重触发间隔 单次触发仪器多次响应的时间间隔，同为定时器触发模式下的触发周期 

触发输入-电平 

电平门限 设置电平触发门限值，高于门限值表示达到触发条件 

防抖安全时间 设置电平触发防抖安全时间 

触发输入-定时器 

定时周期 定时器触发模式下的触发周期 

同步 不与外触发同步、与外触发上升沿同步、与外触发下降沿同步、 

与外触发上升沿单次同步、与外触发下降沿单次同步、与 GNSS-1PPS 上

升沿同步、与 GNSS-1PPS 下降沿同步、与 GNSS-1PPS 上升沿单次同步、

与 GNSS-1PPS 下降沿单次同步 

10.3 中频输出应用指南 

模拟中频输出信号的频率在 307.2 MHz±50 MHz 之间，每台仪器模拟中频输出的中心频率，可以在仪器的

中频校准文件中查看。 
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10.4 外部参考时钟输入 

参考时钟输入的波形可以选择正弦波、方波或削峰正弦，频率必须设置为 10 MHz，幅值为 3.3V CMOS 电

平。 

下面以 GPSDO 作为 10 MHz 参考时钟输入： 

1. 将 GPSDO“10 MHz”口通过 BNC 转 MMCX 线连接至仪器的“RI”接口。连接图如下所示： 

 

2. 点击主设置区“Next”-“System”，设置参考时钟频率“RefCLKFreq“为 10 MHz，参考时钟源“RefCLKSource”

选择“External”。如果参考时钟源显示“External”则表示切换成功，如果参考时钟源回弹为“Internal”

且出现错误弹窗则表示切换失败，此时可点击“Preset”，重新切换回内部时钟使用。 
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10.5 远程控制指南 

10.5.1 网口直连 

1. 将免驱动带网口的拓展坞连接至仪器上面板的 USB 口（其中 USB3 为 USB 3.0 接口，USB1 和 USB2 为

USB 2.0 接口）； 

 

2. 将拓展坞通过网线连接至计算机或嵌入式仪器的网口； 
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3. 点击菜单栏“File”→“Exit”，退出 SAStudio4； 

4. 按照上述步骤成功连接后，打开“Settings”，选择“Network & Internet”，点击“Properties”； 

5. 进入以太网，找到 IP 部分点击“Edit”； 

 

6. 选择“Manual”设置 IP，开启 IPv4 选项，设置 IP 地址与子网掩码（计算机的 IP 与仪器 IP 需在同一

网段下）。例如将电脑 IP 地址设置为 192.168.1.2，子网掩码设置为 255.255.255.0； 
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7. 打开 cmd 窗口，输入“ping 192.168.1.100”，若可以 ping 通，则网络连接成功； 

 

8. 进入 PC 端\SAStudio4\configuration\文件夹，双击打开 Settings.ini 文件，将 Interface 设置为 ETH； 

 

9. 点击仪器桌面“Userdata”→“SAStudio4_X.XX.XX”→“bin”→“CalFile”，将其中的校准文件通过拖

放的操作，保存至外接存储仪器中。 
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10. 将仪器校准拷贝至 PC 端“..\SAStudio4\bin\CalFile“中，双击 PC 端“SAStudio4\bin”下的 SAStudio4.exe，

打开 SAStudio4 界面，实现对 PX 系列仪器的远程控制。 

 

注：仪器与 PC 端的 SAStudio4 不能同时开启。 

10.5.2 局域网连接 

1. 将免驱动带网口的拓展坞连接至频谱仪上面板的 USB 口（其中 USB3 为 USB 3.0 接口，USB1 和 USB2

为 USB 2.0 接口）； 

2. 将拓展坞通过网线连接至路由器的网口； 
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3. 点击菜单栏“File”→“Exit”，退出 SAStudio4； 

4. 点击“userdata”→“Tools”→“Open Current Folder in Terminal”； 

 

5. 在终端中输入“ifconfig”查询当前路由器给仪器分配的 IP 地址，本例中 IP 地址为“192.168.31.55”; 
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6. PC 端通过 WIFI 连接到同一个路由器，与频谱仪处于同一个局域网中，并进入\SAStudio4\configuration\

文件夹，双击打开 Settings.ini 文件，将 Interface 设置为 ETH，将 Address 设置为“192.168.31.55” 

 

7. 点击桌面“Userdata”→“SAStudio4_X.XX.XX”→“bin”→“CalFile”，将其中的校准文件通过拖放的

操作，保存至外接存储仪器中； 
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8. 将仪器校准拷贝至 PC 端“..\SAStudio4\bin\CalFile”中，双击 PC 端“SAStudio4\bin”下的 SAStudio4.exe，

打开 SAStudio4 界面，实现对 PX 系列仪器的远程控制。 
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11. 软固件更新 

本章介绍了如何使用软固件更新程序更新 PX 设备的 MCU 固件、FPGA 固件、GNSS 固件以及 SAStudio4 软

件 

11.1 软固件更新规则 

仪器软固件更新需满足以下版本要求：固件版本需为 0.54.0 或更高，若更新 GNSS 模块，MCU 固件版本

需达到 0.55.32 或以上。版本查看方式如下：点击菜单栏中的“System”-“About”，查看当前仪器版本

信息。 

 

仪器更新软固件后，需确保仪器 MCU 固件、FPGA 固件、SAStudio4 软件（API）在同一大版本内才能正常

使用，不同大版本之间互不兼容，例如同为 0.55.x 才可正常使用。 

11.2 软固件更新包获取 

进入 HAROGIC 公司官网（http://www.harogic.cn/resource/firmware-updater/）下载并解压软固件更新包至

桌面。 

http://www.harogic.cn/resource/firmware-updater/
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11.3 Updater 更新软固件 

注意：若按照流程更新时出现错误，请参考异常处理章节。 

1. 请完全参照远程控制指南章节网口直连部分，连接仪器至 PC，并保证 PC 可以 Ping 通仪器； 

2. 进入 Updater 0.55 M39F15 文件夹，双击运行 Updater_Win.exe； 

 

3. 仪器在使用固件更新程序时，优先会进行 SAStudio4 软件更新，如图所示等待 2 分钟左右即可完成更

新。在此期间，仪器显示-1 等报错不用处理，等待完成更新即可； 
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4. 更新完毕 SAStudio4 软件后，程序会显示当前仪器的固件版本和更新程序中的固件版本，确认无误

后，按回车开始更新。（后续以 Updater 0.55 M39F15为例，M39 即MCU为 0.55.39，F15即 FPGA为 0.55.15）； 

 

5. 更新时终端会显示更新进度，MCU 更新时间大概为 4 分钟，FPGA 更新时间大概为 15 分钟； 

 

6. GNSS 固件会在程序运行时自动更新； 
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7. 更新完成后，按回车结束更新或直接点击右上角叉号关闭程序即可； 

 

8. 重启仪器查看更新情况。 
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11.4 .deb 安装包更新 SAStudio4 软件 

若只更新 SAStudio4 而不更新固件或无法使用网口远程控制仪器，则可直接使用.deb 安装包更新。具体流

程如下： 

1. 进入 HAROGIC 公司官网（http://www.harogic.cn/resource/firmware-updater/）下载 PX 系列软件安装

包并拷贝至 U 盘； 

 

http://www.harogic.cn/resource/firmware-updater/
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2. 正常打开仪器，点击菜单栏“File”→“Exit”，退出 SAStudio4； 

3. 使用 USB 或 Type-c 接口的 Hub，将携带.deb 安装包的 U 盘以及鼠标键盘连接至仪器； 

 

4. 将 U 盘中的.deb 安装包拷贝至仪器中； 

5. 点击 Tools，然后点击 Open Current Folder in Terminal 打开终端； 
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6. 输入 cd ~/Desktop/进入桌面； 

7. 输 入 sudo dpkg -i CN_PXConfig_2.55.29.11.deb （ 注 ： 输 入 指 令 时 ， deb 包 的 版 本

“CN_PXConfig_2.55.29.11.deb”按照实际使用的版本输入）安装.deb 安装包并按提示输入密码 rpdzkj； 

 

8. 之后等待安装包运行完毕即可； 
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9. 软件更新后，查看 SAStudio4 软件 GUI 与 API 确认是否已更新为最新版。 

 

11.5 异常处理 

11.5.1 固件检测异常处理 

若在固件更新过程中，Updater 程序出现如图所示无法检测到固件的错误，无需操作，继续等待至程序检

测到固件即可。 
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11.5.2 固件损坏异常处理 

仪器若在更新 MCU、FPGA、GNSS 过程中因为网线断连或断电等意外情况导致固件更新失败，请重启

Updater 程序，等待 SAStudio4 更新，之后出现如图所示情况，按提示将仪器型号输入到终端并按下回车

重新更新（此处以 PXE-200 R3 仪器为例）。 

 

等待更新完成后关闭程序即可。 
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11.5.3 SAStudio4 误删处理 

若在平时使用仪器时误删 SAStudio4 导致仪器无法使用，此时可按照.deb 更新 SAStudio4 流程修复

SAStudio4。 

11.5.4 SAStudio4 更新异常处理 

若在更新 SAStudio4 过程中因为网线断连或断电等意外情况导致 SAStudio4 损坏，再次更新出现如图所示

提示，此时需先按照.deb 更新 SAStudio4 流程修复 SAStudio4，之后即可正常按照 Updater 更新软固件流

程更新固件。 
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